
8. Using the WinFlume Software 

8.1 Introduction 

The previous chapters have emphasized that a primary advantage of long-throated 
flumes and broad-crested weirs is that they can be calibrated and designed using 
computer software based on established hydraulic theory, as opposed to most other 
critical-flow measurement devices which require laboratory calibration. This 
characteristic makes it possible to design structures for custom applications, 
optimize designs to meet specific operational criteria, and develop rating tables and 
rating equations for as-built structures. 

Chapter 6 presented the hydraulic theory and calculation procedures used to develop 
the head-discharge relation for a long-throated flume or broad-crested weir. This 
chapter describes the use of the WinFlume software for developing rating tables and 
other output based on rating tables, and also shows how to use the program to 
develop designs for new structures. WinFlume is the latest in a series of flume 
analysis and design programs developed since 1984, initially through the 
cooperative research efforts of the Agricultural Research Service and the 
International Institute for Land Reclamation and Improvement, and now including 
the U.S. Bureau of Reclamation. Table 8.1 summarizes the evolution of these 
computer programs. 

Table 8.1 Computer software for flume analysis and design. 

Program 
Flume 

FLUME 1.0 

FLUME 2.0 

FLUME 3.0 

WinFlume I .O 

~ 

Reference Source Code Characteristics 
Replogle. 1975. Criticu1jlowjlurne.s with Basic Developed rating table only for 
coniplex cross section. 

Bos, Replogle and Clemmens, 1984. 
Flow Meosirririg Flrinies for  Open 
Cliannel Systems 
Clemmens, Replogle and Bos, 1987b. 
FLUME: A Computer Mudelfiir 
E~tiniating Flow Rntes tlir~irrgh Long- 
Throoted Measuring Flumes 
USDA ARS-57 

Clemmens, Bos and Replogle, 1993. 
FLUME: Design arid Culibration o/ 
Long-Throated Measuring Flumes 
lLRl Prrblicatiori 54 
Clemmens, Wahl, Bos, and Replogle, Visual Basic 4.0, for 
2001. Water Measurement with Flurnes Microsofl Windows 
arid Weirs (This book) 

trapezoidal and complex 
trapezoidal shapes. 
Develops rating tables for 
trapezoidal flumes at given head 
values. Included modular limits. 
Similar to FLUME I .O. except 
options for cross-section shapes 
greatly expanded, head-discharge 
equations provided. and rating 
tables for given discharge values 
provided 
Interactive, allows for calibration 
and design of flumes with design 
optimization to meet a particular 
head loss objective. 
Interactive, graphical user 
inlerface, calibration of existing 
structures, improved design 
module, enhanced output 
capabilities. 

FORTRAN IV 

FORTRAN IV 

Clipper, compiled for 
MS-DOS 
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8.2 Computer System Requirements 

The WinFlume program has been compiled in a 32-bit version for computers running the 
Windows 95/NT and more recent operating systems, and a 16-bit version for computers 
running Windows 3.1. The two program versions are nearly identical in their capabilities 
and use. The recommended minimum computer hardware for running WinFlume is 

16MBRAM, 
VGA display, and 

WinFlume also runs on computers with older processors or less memory, but the 
configuration described above is recommended for satisfactory performance. 

Intel Pentium processor or equivalent, 

Approximately 8 MB free hard disk space. 

8.3 Obtaining the Software 

The current version of the WinFlume software is maintained on the U.S. Bureau of 
Reclamation’s Water Resources Research Laboratory Internet site at 
www. usb~gov/wrrl/winJlume. The setup kits can be downloaded from this site, 
free of charge. As a product of the U.S. government, WinFlume is public-domain and 
can be copied and distributed freely to others, as long as appropriate recognition is 
given to its developers. 

8.4 Installation 

Ij”you downloaded WinFlume from the Internet 
First, be sure that you have the correct version of WinFlume for your operating 
system. Windows 3.1 users must use the 16-bit version. Users of Windows 95 or 
Windows NT (or more recent versions of Windows) should use the 32-bit version. To 
begin the installation, you must extract the setup kit from the compressed file that 
you downloaded. To do so, execute the file you downloaded by double-clicking on it. 
Detailed installation instructions will be available from the WinFlume web page on 
the Internet (see Section 8.3). 

Ifvou have the WinFlume CD-ROM 
Insert the CD-ROM into your CD-ROM drive. On most computers, this will 
automatically start the installation process. If not, run the INSTALL.EXE program 
located in the root directory of the CD-ROM, or the appropriate SETUPEXE 
program located in the lSETUP32lDISKl or SETUP1 6lDISKl directory. 
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8.5 Starting the Program 

Once installation is completed, WinFlume may be started from the Windows Start 
Menu, or by double-clicking on the WinFlume icon located in the WinFlume 
program group. 

The 32-bit version of WinFlume can also be started from a DOS prompt and accepts 
one optional command-line parameter: 

winflume ylume.$m] 

where$ume.$m is the name of a flume file to be loaded on program startup.You can 
also drag and drop a *.$m file onto the WinFlume program icon to start the 
WinFlume program with a particular flume file loaded. 

In Windows 95/NT, you can define a default open action for the FLM file type, 
which will allow double-clicking on any *.$m file to start WinFlume with that file 
loaded. For detailed instructions on accomplishing this, please refer to “associating 
jles” in the Windows online help system. 

8.6 Software Overview 

Use of WinFlume is relatively straightforward. After starting the program you may 
load an existing flume file from the File menu, or create a new flume definition using 
the File I New Flume command. A helpful flume wizard is available to guide you 
through the initial data entry process, whether it be for an existing structure or an 
entirely new design. Once you have defined the geometric and hydraulic properties 
of a structure and site, you may calibrate that structure or review and refine the 
design using the design reports and design evaluation module. 

WinFlume loads and saves files in its own *.$m file format. One flume definition is 
contained in each *.$m file. Flume designs can be shared among users simply by 
copying the appropriate *.$m file to another user’s computer. WinFlume is also able 
to import flume designs that were created using the FLUME 3.0 program. Once a 
flume definition is imported into WinFlume, modifications of that design can only be 
saved in the WinFlume *.$m file format. 

Online help is available throughout the WinFlume program, or separately by loading 
the.help file from the icon created during program installation. Within the WinFlume 
program, you may press F1 at any time to obtain context-sensitive help on the 
program operation you are currently carrying out. You may also obtain help on the 
use and meaning of objects and controls on the screen by clicking the @d button on 
the toolbar (all versions), or the 1 button located in the top-right comer of most 
dialog boxes (32-bit version only), then clicking on a particular object on the screen. 
A printable user’s manual is also installed with the program and can be viewed or 
printed using the Adobe Acrobat Reader, version 4.0 or later. An installation kit for 
Adobe Acrobat Reader is included on the WinFlume CD-ROM. 
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Figure 8.1 The main screen of WinFlume, displaying the bottom profile dimensions, cross-section 
shapes, and brief design review report. 

WinFlume is operated primarily from a main screen (Figure 8.1) that provides an 
editable view of the bottom profile of the canal and flume structure and access to 
screens that display and allow editing of canal and flume cross-section shapes. 
Screens related to additional flume properties, design requirements, review and 
analysis of design alternatives, and the generation of rating tables and other output 
are accessed either from the menus located near the top of the screen, or from 
buttons located in the toolbar beneath the menus. Each toolbar button is equipped 
with an explanatory text tag that is displayed for 2 seconds if the mouse pointer is 
positioned over a toolbar button for more than 112 second. 

8.6.1 Rating existing flumes and weirs 

WinFlume can rate, or calibrate, existing structures that fit the requirements for 
analysis as long-throated flumes. The rating process consists of using the theory and 
procedures of Chapter 6 to determine the relationship between the upstream sill- 
reference head, h , ,  and discharge, Q. The program can generate rating tables (Q  
versus h,  or h,  versus Q), curve-fit equations relating Q to h ,  for use in data loggers, 
and wall gage data. WinFlume can also compare field-measured Q versus h ,  data to 
the theoretical rating curve of a structure. All these results can be displayed in tabular 
or graphical form, including wall gage templates that are printed to scale. WinFlume 
can also be used as a design review tool to identify design deficiencies in existing or 
proposed structures. 

278 Using the WinFlume Software 



The basic procedure for using WinFlume to rate an existing structure is as follows: 

Create a new flume and use the flume wizard (Section 8.7) to define the 
hydraulic and geometric properties of the structure. If you choose not to use the 
flume wizard, you may enter the dimensions, cross-section shapes and other 
properties of the flume and canal using the bottom-profile screen, the cross- 
section editing screens, and the Flume Properties & Canal Data form, accessed 
from the toolbar or the Flume & Canal menu. 
Open the Rating Tables & Graphs form using the toolbar or the ReportdGraphs 
menu. Choose the type of rating table, the range of head or discharge values to 
include in the table, and optional parameters to include in the rating table. Click 
on the Rating Table tab of the form to view the rating table. (Clicking on this tab 
actually causes WinFlume to perform the rating-table calculations. On fast 
computers, it appears instantaneous.) Check carefully for errors or warning 
messages in the rightmost column of the rating table. These may indicate errors 
in data entry or deficiencies in the flume design. See Section 8.9.4 for rating 
table details. 
Generate a curve-fit equation, wall gage plot, or comparison to measured h,  
versus Q data, if desired. (see Section 8.9) 

8.6.2 Designing new flumes 

The design of a new flume begins in much the same manner as the rating of an 
existing flume (Section 8.6.1). You define the properties and initial dimensions for 
the canal and flume structure, along with the design requirements for the structure. 
The flume dimensions may change during the design process; the initial dimensions 
you enter serve as a starting point for the design. 

After you have defined the flume and canal geometry, design requirements, and 
other properties (on your own or with the aid of the flume wizard), you may use 
WinFlume’s design evaluation reports and tools to review and refine the design to 
meet your design criteria and objectives. The design refinement process can be 
carried out manually, with the user changing flume dimensions and other properties 
until the design review indicates a satisfactory structure, or you can make use of the 
design evaluation module (Section 8.8.3). The design evaluation module will 
analyze a range of flume structures derived from the initial flume, and provide a 
report showing those flumes that are acceptable. You can then choose one of these 
structures and use it as is or make additional refinements to it. 

Once you have obtained an acceptable structure, the various output modules of the 
program (Section 8.9) are used to document the design and produce rating tables, 
rating equations, and wall gage data or plots. 
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8.6.3 Input Data Requirements 

For calibration of existing structures, WinFlume requires data on flume and canal 
dimensions and hydraulic properties. Data are entered on the bottom-profile screen, 
the editing screens for the three cross sections, and on the Flume Properties & Canal 
Data screen, which is under the Flume & Canal menu item. For design of a new 
structure or for review of the design suitability of an existing structure, additional 
data are needed, specifically the water-level measurement method, and freeboard 
requirement. These can be entered on the Flume Properties, Canal Data, & Design 
Requirements screen, which is under the Design menu item. 

WinFlume requires data for some of the fields associated with design, even though 
the user may only be interested in the calibration of an existing flume. Some design 
criteria, such as accuracy and freeboard requirements, will not affect the calculation 
of the rating table, but may prove useful if you later wish to review the design of an 
existing structure. 

WinFlume will not accept a tailwater level of zero, and extremely small values can 
be problematic (because they imply that the downstream velocity head is 
unreasonably large). If tailwater levels are not known, either enter a value that is 
about one half the upstream water depth or add a large bottom drop downstream 
from the throat and enter a tailwater depth approximately equal to the upstream 
depth. The rating table generated by WinFlume will list the highest allowable 
tailwater level for each flow rate. 

WinFlume can accept data in several different user-selectable units systems (see 
Section 8.7.3). The units for data entry are generally shown to the right of the 
appropriate text box or list box, or at the upper right corner of the bottom-profile 
screen. For other items, WinFlume provides a list of possible choices and associated 
parameter values. For head measurement method and flume construction material 
roughness, a list box is provided, such that you choose items from the list or enter a 
value directly. In the latter case, we recommend that you enter a new description to 
the text field to indicate that you have not selected an item from the list. For the canal 
roughness coefficient (Manning’s n),  a special expandable box provides a wide 
range of choices. The list can be expanded by clicking on the + sign and values are 
chosen by clicking on them. Alternately a numerical value can be entered. 

8.6.4 Revision tracking 

WinFlume maintains a revision number for each flume defined. This. revision 
number is printed on all program output to permit the user to confirm that output 
produced by the program at different times is all associated with a particular version 
of a flume. When a new flume is created, the revision number is set to 1, and each 
time the flume is modified and saved, the revision number is incremented by 1. The 
revision number is only incremented when properties of the flume or canal that 
affect the rating of the flume are modified. For example, if a flume with a revision 
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number of 1 is loaded, and the sill height is then modified, the revision number will 
be incremented to 2 when the flume is saved. However, if flume revision 1 is loaded 
and only some details of the formatting of the wall gage are changed, then the 
revision number will remain 1 when the flume is saved. 

You should always confirm that flume rating tables, rating equations, and wall gage 
data or plots display the same revision number as the flume data report and drawing 
printout that define the dimensions and other properties of the flume and canal. If the 
revision numbers are different, then the ratings are for a different flume definition; 
the ratings and other output should be reprinted from the most current revision of the 
flume design. WinFlume may at times force you to save a flume with an incremented 
revision number before output can be printed. This ensures that you cannot load a 
flume at two different times, modify it in a different manner each time, and print 
rating tables or other output that have the same revision number, but correspond to 
different flume definitions. 

8.6.5 Using the undo feature 

WinFlume constantly tracks modifications to the flume definition as you work with 
a design and maintains a list of the last ten significant modifications made to the 
structure. You can undo recent changes and revert back to a previous flume definition 
using the Undo command located on the Flume & Canal menu and the Design menu. 
The menu will describe the type of action being undone, for example, Undo Changes 
to Bottom Profile after you have changed one or more of the bottom profile 
dimensions. 

8.6.6 Program output 

Several types of output are available. A flume drawing can be printed, showing the 
bottom profile of the canal and measurement structure and the cross-section shapes 
and dimensions of the approach channel, control section, and tailwater channel. Text 
reports summarizing the flume design data, listing alternative designs, and reviewing 
the flume design relative to the design requirements are also available. Three types 
of flume rating tables are available, as well as a rating equation report, wall gage data 
report, and a report comparing the theoretical rating table to field-measured values of 
Q versus h, .  Finally, full-scale printed wall gages can be produced. In addition, the 
rating tables, rating equation report, and comparative rating table report can be 
presented in graphical form. All output reports and graphs (with the exception of the 
printed wall gages) can also be saved to a file on disk or copied to the Windows 
system clipboard, from which they can be pasted into word processors, spreadsheets, 
or other applications. 
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8.6.7 File handling 

WinFlume stores individual flume definitions in flume files havin names of the 
form *.Jm, where * represents the name of the flume andJm is the file extension. 
These files contain all of the geometric and hydraulic properties of the flume and the 
upstream and downstream canal sections, as well as all pertinent user-preferences 
related to design criteria and output options. These include units system settings, 
rating table ranges, wall gage appearance options, etc. The *.Jm file is a binary- 
format file, and cannot be usefully viewed with a text editor. The WinFlume program 
is the only useful means of viewing and editing the contents of the *.Jm file. To 
share a flume file with another user or transfer it to another computer, simply copy 
the *.Jm file to a floppy disk or onto the other computer. 

Internally, the *.Jm file has three parts. The first 2 bytes of the file is a binary-coded 
integer that identifies the revision number of the file format. The *.$m file format 
underwent several revisions during the development of WinFlume. WinFlume can 
read files in the current format, as well as all previous formats. Files are always 
saved in the latest format, so that the “upgrading” of *.Jm files to the newest format 
is completely transparent to the user. If you are using an older version of WinFlume, 
it is not possible to load a *.Jm file in a newer format. To load this file you will need 
to upgrade your WinFlume installation. 

The next 1012 bytes of the *.Jm file is the flume data structure. This data structure is 
defined in the WinFlume program, and contains all geometric and hydraulic 
properties of the flume, as well as the flume-specific user preferences mentioned 
above. The third part of the *.$m file is the array of measured h,  versus Q data pairs 
used for comparing the theoretical rating curve to actual field data. If the user has not 
entered any h ,  versus Q data for comparison, then this third part of the *.Jm file will 
consist only of a single data pair with values of h ,  = O and Q = O. Each pair of h,  
versus Q data adds another 8 bytes to the length of the file. Thus, the length of the 
*.flm file will be at least 1022 bytes, plus the length of any additional h ,  versus Q data. 

8.6.8 Loading flume designs created by FLUME 3.0 

The DOS-based FLUME 3.0 program stored flume design data and rating tables in 
dBase format files, having an extension of *.DBF. A catalog of flumes was 
maintained, and the dimensions and properties of all flumes were saved together in a 
single file named FLM.DBF. FLUME 3.0 also had a backup function that would 
copy one or more flumes into a backup file that could be used to transfer designs to 
other computer systems. This file was named FLMBAK.DBF. FLUME 3.0 also 
created other DBF files whose base name was derived from the name of the flume. 
These files only contained rating table data computed by FLUME 3.0; the flume 
design data was always in the FLM.DBF file, or its backup, FLMBAK.DBF. 

WinFlume can import designs originally created in FLUME 3.0 from either the 
FLM.DBF or FLMBAK.DBF file. Once loaded into WinFlume, the designs can be 
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